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1. INTRODUÇÃO 

Este tutorial tem a intenção de cobrir completamente o processo da criação de um cenário 

customizado para o MS Flight Simulator 2004 (incluindo solo, pistas e iluminação 

customizada). É um processo cansativo e bastante trabalhoso, mas o resultado é muito 

gratificante, vale cada minuto gasto. 

O guia faz um grande uso do software de modelagem tridimensional GMax, então é 

recomendável que o cenarista tenha pelo menos o conhecimento básico de modelagem nele. 

Não entrarei em detalhes da modelagem em si, pois não é o foco deste tutorial. 

O GMax pode ser encontrado gratuitamente tanto na internet quanto nos CDs do FS2004, 

basta apenas uma chave gratuita para ativação ( mais pra frente será indicado o link ). 

Minha dica é que você não desista no primeiro erro que encontrar. Se der algum problema, 

releia o tutorial com mais calma e analise as imagens (que muitas vezes têm detalhes 

importantes e que passam despercebidos).  

Bom, vamos então começar com os softwares necessários para concretizar isso tudo. 
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2. FERRAMENTAS 

 GMax 1.2 

o Ferramenta de modelagem gratuita para o FS2002. 

 GMax Gamepack FS2004 

o Suíte de utilitários para a exportação dos arquivos do GMax para o FS2004. 

 BGLComp SDK 

o Compilador de arquivos MDL para BGL ( versão 2004 ) . 

 MakeMDL SDK 

o Semelhante ao MakeModel, mas utiliza o formato antigo do FS2002 ( utiliza 

arquivos .ASM ao invés de .XML ). Necessário para o FS2004 também. 

 BGLC 

o Idem BGLComp, mas para o FS2002. Também é necessário, mesmo o cenário 

sendo para o FS2004. 

 BGLC_9 

o Um utilitário para compilar arquivos ASM para o FS9. 

 Middleman 

o Utilitário para exportar arquivos X através do GMax. 

 MDLCommander 

o Idem o item anterior. Ambos necessários. 

 AFCAD 2.21 

o Ótima ferramenta para trabalhar com AI de solo. Sem ela, o aeroporto não 

possuirá informações de táxi, parkings, pistas, etc... 

 Fergo Texture Converter 

o Uma ferramenta que eu mesmo fiz para converter diversas imagens para 

outros formatos de uma vez ( batch ). 

 FSUIPC 3.7 

o Esse módulo cria uma conexão entre determinados programas (AFCAD e 

SBuilder no nosso caso) e o FS. Assim você consegue adquirir diversas 

informações sobre o avião e colocá-las num aplicativo externo ao FS . 

 SBuilder 2.05 

o Um ótimo aplicativo para se trabalhar com o solo. Muito útil para nivelar 

determinada área e deletar objetos indesejados. 

 SCASM 2.96 

o Compilador de arquivos SCM. Necessário para o Sbuilder. 

 Arquivos usados neste guia 

o Arquivo 7z (7Zip) contendo todos os arquivos usados neste tutorial, incluindo 

solo fotoreal. 

 

 

 

 

 

http://www.turbosquid.com/gmax
http://download.microsoft.com/download/4/d/e/4de1e425-c932-4232-829b-eeb7f2658885/fs2004_sdk_gmax_setup.exe
http://download.microsoft.com/download/b/9/3/b930da2a-b3bf-40dc-b830-b1da916eb9e2/fs2004_sdk_bglcomp2_setup.exe
http://download.microsoft.com/download/FlightSim2002/Install/sdk/W982KMeXP/EN-US/MakeMDL_SDK.exe
http://download.microsoft.com/download/FlightSim2002/Install/sdk/W982KMeXP/EN-US/bgl_compiler_sdk.exe
http://www.fergo.5gigs.com/files/BGLC_9.zip
http://thegreatptmd.tripod.com/downloads/Middleman13beta3.zip
http://hometown.aol.de/_ht_a/docmoriarty3/fs2002/dl/MDLCommander.zip
http://mysite.verizon.net/tdgsr/downloads/afcad221.zip
http://www.fergonez.net/files/fergo_texconv.zip
http://www.fergonez.net/files/fergo_texconv.zip
http://www.schiratti.com/files/dowson/FSUIPC.zip?timestamp=280406
http://www.ptsim.com/downloads/sb205.zip
http://www.scenery.org/_downloads/sca296.zip
http://www.fergonez.net/fs2k4.php
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3. PRELIMINARES 

Antes de por a mão na massa, precisamos acertar algumas coisas para evitar confusão. A maior 

complicação é o fato de às vezes você ter que usar os compiladores do FS2002, e às vezes o do 

FS2004. Vou explicar um pouco sobre isso. 

No FS2002, os arquivos dos cenários (BGL) eram gerados a partir de arquivos programados na 

linguagem assembly (linguagem de máquina, mais baixo nível possível), e somente os mais 

experientes conseguiam modificar e entender esse tipo de arquivo. Na versão 2004, ele foi 

substituído pelos XMLs, bem mais legíveis, mas restringem um pouco a capacidade de 

alteração. 

Quando eu devo usar cada um? Simples. Sempre que você estiver trabalhando com o solo do 

aeroporto (excluindo iluminação e objetos 3D), você vai ter que usar o MakeMDL e o BGLC do 

FS2002 e fazer algumas alterações no código ASM (assembly) para que ele se comporte 

corretamente como um polígono de solo, e não como objeto 3D. Quando você estiver 

trabalhando com luzes e qualquer objeto tridimensional, você vai usar as ferramentas do 

FS2004. 

Mais pra frente você vai entender melhor como funciona. 

 

Outra parte chata que tenho que ressaltar é na hora de exportar. Instalando o Gamepack do 

FS2004 no GMax, você só consegue exportar arquivos para o novo formato ( XML, como 

descrevi acima ). Até aí tudo bem, porque é automático. O problema é quando você precisa 

utilizar o método do FS2002, já que o GMax exporta somente para o 2004. 

Felizmente existe um utilitário que antes de salvar o arquivo para o FS2004, intercepta o 

processo e permite que você salve os arquivos fontes para poder alterá-los (aquelas alterações 

no código ASM que eu mencionei). 

 

Vou aproveitar e já explicar como fazer isso. Antes, precisamos ter o GMax Gamepack 

instalado em um diretório FORA do diretório do GMax ( um diretório qualquer ). Não instale 

ele junto com o GMax pois não queremos mais confusões. Tenha em mãos os utilitários 

MDLCommander e Middleman também. 

Depois de instalar o GMax gamepack num diretório qualquer, copie os arquivos  

‘FSModelExp.dle', 'makemdl.exe' e 'makemdl.parts.xml' da pasta ‘gamepacks\fs2004\plugins’ 

para a pasta  ‘gmax\plugins’. Renomeie o ‘makemdl.exe’ para ‘mkmdl.exe’ e o 

‘makemdl.parts.xml’ para ‘mkmdl.parts.xml’. Agora descompacte o MDLCommander dentro da 

pasta ‘plugins’ do GMax e renomeie para ‘makem.exe’. Finalmente, extraia o conteúdo do 

Middleman para essa mesma pasta e renomeie para ‘makemdl.exe’. Um tanto quanto confuso 

para uma primeira lida, mas é só ler novamente que você capta a idéia. 

 

Agora sim, mão a massa! 
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4. PREPARANDO AS IMAGENS FOTOREAIS 

4.1 Capturando imagens do GoogleEarth 

A primeira coisa que devemos fazer em algum cenário é o solo, pois ele servirá de base para o 

posicionamento dos objetos a das marcações. Essa é a etapa mais chata de todo o trabalho, 

pois exige muita paciência (proporcional ao tamanho do aeroporto). Claro que ela também 

será o solo fotoreal, então precisamos arranjar uma boa fonte de imagens aéreas. Com certeza 

o GoogleEarth é a melhor fonte para os cenaristas, pois tem alta qualidade e é gratuito ( 

lembre-se de que as imagens de satélite tem direitos autorais, então você não pode fazer o 

uso comercial delas, a não ser que obtenha a versão PRO do GoogleEarth. 

Antes de começar captura das imagens é bom lembrar uma coisa: a resolução da foto é 

inversamente proporcional altura. Se você capturar as imagens a 1000 metros de altura, ela vai 

ter uma resolução menor do que se você capturar a 300m. Isso cabe a você decidir. Como se 

trata de um solo de aeroporto e que precisa ter qualidade, eu recomendo uma altura de 400 

metros mais ou menos (claro que quanto mais próximo você tiver do solo, mais imagens você 

vai ter que tirar, e mais trabalho vai ter).  

Eu vou escolher o aeroporto de Maringá (PR) para escrever esse tutorial, pois possui boas 

fotos aéreas, boas referências do terminal e poucos edifícios. Decidi optar por fotos a 550m de 

altura (não vai ficar com uma resolução muito grande, mas é suficiente para ficar um trabalho 

bacana). 

Certo, abra o Photoshop e crie uma nova imagem de 3500x3000 com fundo transparente (é 

uma imagem relativamente grande, por isso o computador tem que ter bastantes recursos 

disponíveis). 
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Em seguida, abra o GoogleEarth, vá ate o aeroporto desejado (Maringá, no caso), posicione a 

câmera numa altura de 550m acima do solo e escolha um local por onde começar (escolhi a 

região da cabeceira 09). 

OBS.: Certifique-se de que você está orientado direto ao norte 

 

Agora começa a parte chata. No GE (GoogleEarth), capture uma screenshot  botão Print 

Screen), vá ao Photoshop, crie outro documento em branco (o tamanho ele vai acertar 

automaticamente para o tamanho da screenshot que você tirou) e cole a imagem capturada.  

Você vai obter algo mais ou menos assim: 

 

Em seguida, selecione somente a área que interessa (pegando somente a imagem em si, 

descartando textos), copie e cole naquele documento de 3500x3000. Agora você já tem uma 

pequena parte da grande imagem. Você tem que repetir esse mesmo processo  até que você 

consiga pegar toda a área desejada. É mover, copiar, colar e alinhar (cuide bem com o 

alinhamento, para não deixar uma marca).  

 

Depois de ter montado, vá em Image->Trim. Configure como na imagem. Isso fará com que o 

PS deixe somente a imagem, e remova tudo o que é transparente. Você vai obter algo mais ou 

menos assim (em tamanho reduzido aqui): 
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Vamos agora apagar aquilo que não interessa (afinal, não queremos aquele monte de quebra 

nas bordas). Tirar isso é fácil, da para fazer na  mão. Selecione a ferramenta Erase no PS e 

apague toda aquela borda picotada, deixando somente a parte referente ao aeroporto. 

Sugiro usar a borracha no modo Brush, pois deixa uma borda suave. 

 
 

4.2 Medindo a resolução da imagem 

Essa parte é crucial, ela que vai definir a escala da imagem. O método que eu vou descrever 

aqui não é o mais preciso, mas para o que nós queremos, já é necessário. 

A resolução é dada em metros por pixel. Por exemplo, se uma imagem tem uma resolução de 

2 metros por pixel, cada pixel da imagem vai corresponder a 2 metros no jogo. Agora você 

entende porque que quanto mais próximo do chão for a foto, maior a resolução. 

Talvez você já tenha entendido o que devemos fazer, mas vou explicar. O meu método é 

escolher 2 pontos de referência na horizontal ou vertical e medi-los no GE através da 

ferramenta Measure. Eu escolhi medir a distancia das bordas do piso de concreto (repare que 

a linha é na vertical). A medida que eu obtive foi de aproximadamente 125 metros. 
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Certo, já temos a medida em metros, agora precisamos descobrir quantos pixels tem essa 

mesma distância. Vá a sua imagem no PS, selecione a ‘Rectangle Marquee Tool’, crie um bloco 

de seleção de modo que uma das laterais fique na mesma posição da linha medida no GE. Em 

seguida aperte CTRL+C. Vá em ‘File->New’ e veja o tamanho do documento sugerido para essa 

imagem. Como nós criamos uma linha na vertical, nós devemos dar atenção ao campo Height ( 

altura ) da seleção, pois ali se refere ao número de pixels na vertical da seleção. No meu caso, 

o Height deu 110 pixels. 

Agora é matemática. Se a resolução é metros por cada pixel, é só fazer uma regra de três. 110 

pixels estão para 125 metros assim como 1 pixel está para X metros. Isso nos dá 1.13 metros 

por pixel ( m/px ). Não é uma resolução muito boa para o solo, mas o que importa é que agora 

você já sabe o procedimento. Anote esse valor, nos vamos utilizá-lo mais tarde. 

Estamos quase no final do processo da edição do foto-real, mas antes de redimensionar as 

imagens, nós precisamos apagar todas as marcações que existem nas superfícies (marcas na 

pista, linhas de táxi, marcas no solo de estacionamento, etc). Temos que fazer isso, pois essas 

marcações vão ser feitas no GMax mais adiante, então não há necessidade de deixar elas na 

imagem ( até porque a resolução é baixa demais para criar detalhes precisos ). O resultado 

deve ficar mais ou menos assim: 

 

 

4.3 Quebrando em partes iguais 

Seria muito fácil agora se nós simplesmente aplicássemos essa textura num polígono e 

enviasse para o FS. Infelizmente o jogo suporta no máximo imagens de 1024x1024 ( e a minha 

deu 2573x1024 ). Vamos então quebrar em pedaços de 1024x1024 ( sugiro ir em Image-

>Canvas Size e determinar um valor em pixels que seja múltiplo de 1024, arredondando para 

cima. Como a minha textura era 2573x1024, eu aumentei o tamanho do Canvas para 

3072x1024 ( ambos múltiplos de 1024 )). 

Para dividir em pedaços iguais, eu crio um retângulo de seleção de 1024x1024 e posiciono na 

minha figura. Para criar esse retângulo, eu seleciono a Rectangle Marquee Tool novamente, 

marco Fixed Size no menu suspenso e determino as dimensões. Agora é só recortar toda essa 

imagem em pedaços de 1024x1024, colar em um novo documento e salvar no formato PSD 

padrão. Eu sugiro que você use as réguas ( View->Rulers ), assim você consegue dividir melhor 

as seleções. 
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Outra dica é nomear as texturas de forma que fique fácil de saber a sua localização. Eu 

particularmente gosto de nomear como se fosse uma grade ( 1x1, 1x2, 1x3, linha x coluna ). 

Como você pode reparar, a minha imagem resultou em 3 partes de 1024x1024, as quais eu 

nomeei como 1x1.psd, 1x2.psd e 1x3.psd. 

 

Agora você pode fechar o seu Photoshop e o GE, não vamos mais usá-los. Se tiver pouca 

memória livre, recomendo reiniciar o computador antes de abrir o GMax, senão você mata o 

micro. 
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5. PREPARANDO O SOLO 

5.1 Nivelando determinada área 

Algumas vezes o terreno ao redor do aeroporto é irregular, com montanhas, e isso pode 

atrapalhar o andamento do cenário (afinal, você não quer uma montanha bem no meio do seu 

terminal, quer?). Vamos utilizar o SBuilder para criar uma área plana no nosso cenário, para 

que possamos trabalhar mais abertamente. Nem sempre esse processo vai ser necessário, mas 

para o aeroporto de Maringá foi. 

Vamos utilizar o SBuilder para realizar este processo. Antes de começar, descompacte o 

executável do SCASM (mencionado na sessão de links) na pasta ‘SBuilder\Tools\Work’. 

Abra o SBuilder e clique em ‘New’. Na janela do novo arquivo, apenas dê um nome coerente 

para o projeto. Como se trata de uma planificação, eu escolhi o nome de ‘sbmg_plano’. Não se 

preocupe com as outras configurações. Clique em OK 

 

O que nós vamos fazer é criar um polígono 2D que ficará completamente plano. Precisamos 

apenas posicionar os vértices dos polígonos nas coordenadas. Para facilitar o trabalho, vamos 

utilizar o SBuilder em conjunto com o FSUIPC, assim podemos criar o polígono diretamente da 

posição do avião no FS. 

Inicie o Flight no determinado aeroporto e mova o avião (com SLEW, de preferência) para 

algum local onde deseja adicionar um vértice do polígono. Minimize o FS, restaure a janela do 

SBuilder, vá em ‘View->Show Aicraft’. Se você instalou o FSUIPC corretamente, uma pequena 

cruz vermelha apareceu no SBuilder, indicando a posição do avião (assim não precisamos 

sequer saber coordenadas). Agora você pode iniciar a criação do seu polígono. Utilizando a 

ferramenta ‘Poly’, você pode criar uma superfície com quantos vértices quiser. Sempre que 

precisar ter alguma referencia, volte ao Flight, mova a posição do avião e automaticamente ela 

será alterada no SBuilder também. ( recomendo usar bastante a ferramenta Zoom, para ficar o 

mais preciso possível ). 

Depois de ter finalizado a superfície você pode fechar o FS. Ainda temos que definir as 

propriedades desse polígono. Clique com o botão direito sobre uma de suas arestas e vá em 

‘Properties’. Configure a janela da seguinte maneira: 
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Claro que você vai alterar a altitude dependendo do aeroporto que você está trabalhando. No 

meu caso, a altitude do aeroporto é de 545 metros (você pode conseguir a altitude através do 

FS ou do AFCAD). Não se esqueça de clicar em CHANGE após modificar o valor. 

A nossa superfície plana está pronta. Olhem como ficou a minha: 

 

Salve esse arquivo em um local qualquer (ele não vai ser o arquivo final), mas não feche o 

SBuilder. Vamos aproveitar e já criar polígonos de exclusão, pare remover objetos indesejados. 

Veja o item abaixo. 

5.2 Criando um polígono de exclusão 

Em quase todos os casos, um cenário realístico ocupa uma área maior do que a do cenário 

padrão e, por causa disso, objetos indesejados como árvores e edifícios ficam no meio do 

caminho.  

Imagino que você esteja com o arquivo do item anterior aberto ainda. Se não estiver, abra-o. 

Essa parte é extremamente fácil. No menu de ferramentas lá em cima, selecione ‘Excl’ e depois 

desenhe o retângulo do exclude (um clique para iniciar o retângulo, outro para finalizar). Ao 

dar o segundo clique, uma janela de propriedades vai aparecer. Você pode configurar da 
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maneira que quiser. No meu caso, eu quero somente que ele exclua os objetos comuns como 

arvores e edifícios. 

 

Você pode fazer quantos excludes quiser no mesmo arquivo, não precisa ser somente um. 

Vejam como ficou: 

 

Feito isso, vamos então gerar o arquivo BGL que o Flight Simulator vai usar. 

Selecione todos os objetos na cena ( criando um retângulo de seleção que englobe todos os 

objetos ). Vá em ‘File->BGL Compilation’ e configure a janela assim: 
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Clique em ‘Compile’. Aparentemente nada ocorreu, mas o arquivo foi criado. Vá até a pasta do 

‘SBuilder\Tools\Work’ e lá estará um arquivo .SCM com o nome do seu projeto. Esse arquivo é 

o código fonte que o programa SCASM usará para gerar o BGL final. Simplesmente arraste esse 

arquivo .SCM sobre o ícone do SCASM e o BGL será gerado. 

Vamos organizar a pasta do FS onde o seu cenario ficará, para você já mover esse arquivo para 

o local definitivo. Navegue até a pasta ‘…Flight Simulator 9\Addon Scenery’ e crie uma nova 

pasta com o nome do seu cenário ( de preferência ). Entre nessa pasta e crie mais 2, com o 

nome de ‘scenery’ e ‘texture’. Vai ficar algo assim: 

‘…Flight Simulator 9\Addon Scenery\meucenario\scenery’ 

‘…Flight Simulator 9\Addon Scenery\meucenario\texture’ 

Mova esse arquivo BGL criado pelo SCASM para a pasta ‘\meucenario\scenery’. Se quiser, você 

pode entrar no FS para conferir se realmente tudo deu certo. 

 

 

 

 

 

 

 

 

 

 

 



 15 

6. MONTANDO AS IMAGENS NO GMAX 

6.1 Configurando o sistema de medidas 

Já com o GMax aberto, antes de tudo, vamos configurar as unidades, para manter a 

proporção. Vá em Customize->Preferences e ajuste o ‘System Unit Scale’ para 1 unit = 1 meter. 

Depois vá em Customize->Units Setup e selecione Metric ( Meters ) 

 

6.2 Configurando os materiais 

Antes de começar a desenhar os polígonos, vamos preparar os materiais que vão ser aplicados 

neles. No GMax, aperte ‘M’ para abrir a janela de materiais. Nós vamos criar um material para 

cada polígono, pois é mais simples do que criar multi-material. Clique em ‘New’ e ‘Standard’. 

Agora vem um detalhe importante. O nome do material vai definir a ordem de renderização ( 

se ele fica na camada mais acima ou não ). Isso é definido por ordem alfabética. Nomes 

começados com a letra A vão ficar no topo, e os começados com Z ficarão na camada mais 

baixa. Como se trata de uma imagem foto-real de fundo, sugiro usar uma letra do final do 

alfabeto. Eu vou usar ‘Z_bg_1x1’ para o material da imagem 1x1.psd. 

Um pouco mais abaixo do nome, na sessão ‘Blinn Basic Paramiters’, há um pequeno botão 

vazio do lado direito da cor ‘Diffuse’. Clique sobre ele, dê duplo clique em ‘Bitmap’ e selecione 

a imagem 1x1.psd. Agora apareceram na janela as propriedades do bitmap. Clique no cubo 

quadriculado (azul e branco) e altere o valor do ‘Blur’ para 0,01. 
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Pronto, o material referente a imagem 1x1.psd está criado. Repita o mesmo processo (clicando 

em ‘New’...) para todas as imagens do cenário. 

6.3 Desenhando os polígonos do solo 

Agora chegou o momento de montar todas as imagens. Para isso, nós vamos usar um plano 

para cada imagem. No meu caso, eu obtive três imagens quando fiz a separação no OS, então 

vou ter três planos. 

Antes de iniciar a criação, nós precisamos saber a dimensão que cada plano vai ter. Lembram 

da resolução que nós descobrimos? Aqui é que ela vai ser utilizada. Nesse tutorial, a resolução 

é de 1.13 m/px, ou seja, 1 pixel vai ter 1.13 metros. Como cada uma das nossas imagens tem 

1024 pixels, o plano em que ela vai estar terá 1024 * 1.13 = 1157 metros. 

Selecione a ferramenta ‘Plane’ e crie um plano de 1157x1157 com um segmento para cada 

dimensão.  
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Faça diversas copias desse plano e posicione de acordo com a posição de cada uma daquelas 

texturas. É muito importante alinhar os planos numericamente ( não alinhe “no olho” pois não 

funciona, sempre vai ficar deslocado ). Para isso, utilize a ferramenta Align ( Tools->Align... ou 

ALT+A ou clicando sobre o ícone na toolbar ). Basicamente você seleciona aquilo que deseja 

alinhar, seleciona a ferramenta Align, clica sobre o outro objeto e configura os eixos e a 

posição do alinhamento. Essa é o tipo da ferramenta que você só vai aprender usando e 

pegando a prática. 

 

Objetos posicionados e alinhados, vamos então texturizá-los. Creio que você já tenha uma 

noção básica de como fazer isso (como foi sugerido no início deste guia), então não entrarei 

em detalhes. 

6.4 Texturizando e mapeando os polígonos 

No viewport ‘Perspective’, certifique que está selecionado ‘Smooth + Highlights’. Abra a janela 

de materiais novamente e clique sobre o ‘Material Navigator’. Nessa nova janela, selecione 

‘Entire’ na lateral esquerda, selecione uma textura, selecione o plano a ser preenchido e clique 

no botão ‘Apply Material’. 
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Infelizmente o mapeamento parece perfeito somente no GMax. Quando passar isso para o FS, 

por mais perfeito que pareça, você vai conseguir ver algumas linhas na região onde os dois 

planos se tocam. Não se sabe ao certo o porquê disso, mas a única maneira de corrigir é na 

mão, utilizando o modifier  ‘UVW Map’ ou ‘Unwrap UVW’. Como utilizar essas ferramentas eu 

não vou explicar aqui, mas você pode aprender a usá-las lendo o guia de criação de cenários 

que vem junto com o SDK do Flight Simulator 2004. 

Teste diversas coordenadas de texturas, diversos tipos de mapeamento, que uma hora você 

vai conseguir esconder esse problema. Normalmente as linhas não desaparecem por 

completo, sempre fica uma pequena marca, mas se for bem trabalhada, fica difícil de notar. 

Feito isso, analise o conjunto de polígonos e tente achar algum ponto de referencia nas 

texturas, como a cabeceira de uma pista (eu recomendo isso) e mova todos os planos de modo 

que essa referência fique bem no centro de coordenadas do GMax. Isso será de extrema 

utilidade para fazer o posicionamento desses planos no FS2004. 

6.5 Exportando para o Flight Simulator 

Nosso solo foto-real está quase lá, mas antes precisamos exportar para o Flight Simulator. 

Tenha certeza de que você fez corretamente o que foi dito nas preliminares, caso contrário o 

processo de exportação não terá sucesso. 

Ainda no GMax, vá em ‘File->Export’. Selecione um nome (usarei sbmg_ground), local de 

destino (não aconselho a usar as pastas do FS, utilize uma pasta qualquer por enquanto), 

selecione ‘Flightsim Aircraft Object’ como o tipo do arquivo (sim, aircraft mesmo, não scenery) 

e mande exportar. Se você fez tudo direitinho, uma janela do MakeMDL Middleman 

aparecerá. Na aba ‘Options’ dessa janela, configure desta maneira: 

 

Reveja essas configurações e, quando tiver certeza de que está tudo certo, clique em ‘GO!!’. Se 

tudo ocorreu bem, um arquivo X ( sbmg_ground.X ) foi criado no local onde você especificou 

(caso contrário você esqueceu de configurar alguma coisa). 
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Esse arquivo X é o seu foto-real, mas em um formato diferente do GMax. Para transformar 

esse modelo num arquivo que o FS consegue ler, vamos ter que usar o MakeMDL e o BGLC do 

FS2002, (muita atenção quanto isso!). Espero que tenha organizado seus arquivos, para saber 

qual aplicativo é de qual versão do simulador. 

Então vamos lá. Abra o MakeMDL do FS2002 ( MakeMDL – Microsoft Flight Simulator 2002 

SDK 8.00.020403.01 ). Em ‘Input File’ selecione o arquivo X (sbmg_ground.X) e em ‘Model 

Type’ selecione ‘Scenery’. Vá para a aba ‘Options’ e marque os como na imagem abaixo: 

 

Em seguida passe para a aba ‘Scenery’. Nessa aba você define a coordenada na qual será 

posicionado o fotoreal, com relação a origem do sistema 3D ( 0 0 0 ). Por isso que é importante 

posicionar alguma referencia na coordenada 0 0 0 do GMax. Eu coloquei a cabeceira 09 na 

origem do sistema, a sua coordenada geográfica é ‘S23* 28.68 W52* 01.57’ (obtive através do 

Flight Simulator). Basta colar esse valor no campo ‘Latitude and Longitude’. Os outros campos 

podem ficar em branco, a não ser que você tenha alterado a angulação dos seus planos, etc... 

Quando estiver tudo configurado, clique em ‘Start’. Se não acusar nenhum erro, você tem 

agora mais três arquivos junto com o X: 

sbmg_ground.bgl 

sbmg_ground.asm 

sbmg_ground_0.asm 

Esse arquivo BGL ainda não é o arquivo final, pode ser deletado. Como você pode ver, foram 

criados os arquivos ASM mencionados lá no começo do guia. É um arquivo de texto simples, 

portanto, pode ser aberto no bloco de notas. Abra o ‘sbmg_ground.asm’ no bloco de notas. 

Humm, um pouco assustador não é mesmo? Mas fique tranqüilo, não vamos precisar entender 

o que cada linha dessas faz (isso fica como uma tarefa, caso queira se aprofundar). 

Até agora o seu suposto solo foto-real não é um solo legítimo do FS. Por enquanto ele é 

considerado um modelo 3D comum, nos quais as sombras não se projetam (o que é ruim, já 

que ele ficaria no solo e naturalmente receberia sombras). Precisamos fazer uma pequena 

alteração no ‘sbmg_ground.asm’ para que ele se comporte como um ground poly. 
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Procure nesse arquivo por estas linhas ( normalmente entre as linhas 20 e 30): 

IFIN1       OBJECT_0_FAIL, image_complex, 2, 32767 

ADDOBJ      OBJECT_0_SCALE 

SHADOW_CALL OBJECT_0_SCALE 

Substitua tudo isso por: 

IFIN1       OBJECT_0_FAIL, image_complex, 2, 32767 

ADDCAT OBJECT_0_SCALE, 8 

Não vale a pena explicar o que cada argumento faz, mas é bom ressaltar um deles: o ‘8’, na 

útlima linha. Ele representa a camada (layer) do polígono no FS2004. 8 é a camada padrão para 

polígonos de solo, então pode deixar como está (use sempre números pares). 

Salve esse arquivo. Agora chegou o grande momento de gerar o BGL final. Para isso você vai 

usar o BGLC.exe ( versão do FS2002 ). Simplismente arraste o arquivo ‘sbmg_ground.asm’ 

sobre o BGLC.exe e automaticante um arquivo BGL, com o mesmo nome, é gerado no local 

onde se encontra o .asm. 

OBS.: Toda vez que você utilizar o MakeMDL, um novo ASM será gerado e você tem que 

refazer essas alterações. 

Agora você pode mover o arquivo BGL final para a pasta ‘meucenario\scenery’. 

Não entre no FS ainda, pois temos que converter as texturas. 

6.6 Convertendo as texturas 

Esse processo é rápido. Tenha em mãos o meu aplicativo ‘Fergo Texture Converter’. Utilize-o 

desta maneira: 

1) Selecione o diretório onde se encontram os arquivos .psd das texturas 

2) Marque as imagens necessárias ( 1x1, 1x2, … ) 

3) Selecione o diretório de destino (  ‘meucenario\texture’ ) 

4) Utilize o formato DXT3 com apenas essas opções marcadas: Gerar Mipmaps e Utilizar Alfa 

5) Marque ‘Preservar nome original das imagens’ 

6) Clique em ‘Iniciar Conversão’ 

 

 



 21 

 

Assim que clicar, uma janela do prompt do DOS irá aparecer processando e convertendo as 

imagens. Quando ela fechar, é porque o processo está finalizado e as imagens já estão no 

diretório de destino. 

Agora você já pode ir no Flight Simulator e ter uma pequena prévia de como ficou o seu 

cenário fotoreal. Não se esqueça de adicionar a pasta do seu cenário no FS ( Settings->Scenery 

Library->Add Area ). Reinicie o FS e veja o resultado! 
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7. CRIANDO O SOLO DO AEROPORTO 

7.1 Pista de pouso, taxiways e aprons 

Entramos agora na parte que realmente deixa o aeroporto com uma cara nova, mais bonita e 

realista. Todos sabem que a parte de solo do aeroporto padrão do FS não é real, muito menos 

bonita, então cabe a nós melhorar isso. 

Antes de começar a modelagem, você precisa fazer uma escolha. Criar as pistas, taxiways e 

marcações no mesmo arquivo do ground, ou criar em um arquivo separado. Eu 

particularmente prefiro separar os arquivos (1 para o solo foto-real, 1 para pistas, taxiways e 

aprons e outro para as marcações), pois a chance de ter problemas com layers é menor. Vou 

então explicar como fazer com arquivos separados (o trabalho é praticamente o mesmo, a 

única diferença é que você vai ter mais arquivos). 

Para iniciar, faça uma cópia do arquivo do foto-real do GMax. É nessa cópia que vamos 

trabalhar. Vou fazer um pequeno resumo de como devem ser as texturas e os procedimentos 

para fazer algo bacana. 

 Use texturas grandes, de 512x512. Se for fazer uma superficie de concreto que tem 

aquelas divisoes quadradas, faça apenas 1 quadrado de 512x512 bem detalhado e 

depois repita essa textura várias vezes no GMax 

 Deixe sempre um pouco de transparência nos planos, para que o solo foto-real tenha 

uma mescla melhor com as superfícies 

 Use diversas camadas de planos se for necessário, uma de baixa resolucao no fundo, 

uma de alta resolucao sobre ela com um pouco de transparencia, mais uma apenas 

com detalhes, etc... não tenha medo de usar essas camadas 

Vejam algumas texturas em tamanho reduzido aqui: 

 

( marcas de pneu, asfalto, marcas na pista, concreto ) 

Com a cópia do solo aberta no GMax, comece desenhando um plano sobre toda a região onde 

se localiza a pista (use a propria imagem foro-real do fundo como base). Lembrando que eu 

não vou ensinar a modelar passo a passo, vou apenas indicando os procedimentos. Leia o 

guida de modelagem contido no SDK do FS2004 caso queria aprender as técnicas. 
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Reparem que eu já fiz também as áreas de overrun. O próximo passo é adicionar as texturas. 

Imagino que você já saiba como fazer isso e aplicar aos objetos. Caso não saiba, releia o 

capítulo 4 deste guia. 

Crie os materiais que serão usados na pista (superfície asfáltica, concreto para as cabeceiras, 

uma branca para as marcações e uma para as marcas de pneu). Lembre-se de nomear as 

texturas que ficam na camada mais inferior utilizando letras do final do alfabeto (deixe o 

asfalto por ultimo, as marcas no meio e as marcas de pneu sobre todas elas). Recomendo 

deixar cada um dos materiais com um certo nível de transparência. Quanto exatamente eu não 

vou dizer, pois vai variar de acordo com a imagem de fundo, mas acho que 80% de opacidade 

é um bom valor para começar (isso é alterado na janela de materiais). 

Aplique as texturas nos polígonos. Provavelmente elas ficaram completamente esticadas, e 

não é isso que queremos. Precisamos ajustar a repetição delas. Selecione um dos planos, vá na 

aba ‘Modify’ e selecione ‘UVW Map’ na lista de modificadores. Agora você tem que trabalhar 

com o U e V Tile ate que chegue num resultado que você considere satisfatório. 

 

Nesse exemplo do tutorial eu usei apenas uma camada para a textura básica, por isso o 

resultado não vai ser dos melhores. Aconselho a utilizar mais camadas de detalhes quando 

fizer um cenário pra valer, pois vai ficar muito mais detalhado. 
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Feito isso, vamos então adicionar as marcas na pista. Novamente você vai criar os materias 

que necessitar e dar um pouco de transparência. Eu usei basicamente uma textura branca com 

um pouco de noise e 80% de opacidade. 

As marcas são criadas com planos também, da mesma forma que todo o resto, e por isso não 

vou mostrar passo a passo a criação de cada uma das marcas. (lembre-se de nomear as 

texturas corretamente). 

 

DICA: Adicione também marcas de pneu na pista. Depois disso tudo, você já deve saber o que 

fazer. 

Nossa pista está feita. Vamos fazer agora os pavimentos de taxi e estacionamento (aprons). O 

procedimento é exatamente o mesmo utilizado na pista. É só desenhar o polígono e depois 

texturizar, com um nível de transparência. Quando terminado, você terá algo assim: 
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Reparem que eu removi aquela imagem de background depois que terminei essa modelagem, 

pois se você exportar com o fundo, nós vamos ter 2 foto-reais sobrepostos no flight (o do BGL 

do solo e este aqui).   

Com o fundo removido, o processo de exportação é exatamente o mesmo que o do solo 

fotoreal. Só precisamos mudar uma coisa: a camada em que esse BGL vai ficar. Lembram 

quando eu comentei sobre aquele número ‘8’ que deveria ser modificado no arquivo asm? 

Então, temos que alterar ele agora. Ao invés de colocar aquelas linhas com o valor 8, coloque 

com um valor maior, pois esse BGL deve ficar sobre o fundo foto-real. Eu sugiro a camada 

número 16. Vai ficar assim: 

IFIN1       OBJECT_0_FAIL, image_complex, 2, 32767 

ADDCAT OBJECT_0_SCALE, 16 

Lembre-se também de converter as texturas para o formato que o FS consegue ler. Para isso, 

repita o processo do ítem 6.6, selecionando, obviamente, somente as texturas queo vccê usou 

na pista/taxiway/aprons. 

Depois de exportar, pode colocar o BGL gerado na mesma pasta ‘meucenario\scenery’ e ver o 

resultado no FS. 

7.2 Taxilines e marcações no solo 

Esse ítem é a cereja do bolo. Ele que dá um toque todo especial e original ao seu aeroporto. 

Vamos começar com as taxilines. Para fazê-las, vou usar uma técnica chamada ‘Lofting’, que 

consiste em repetir um determinado polígono ao longo de uma linha. 

Como eu disse, gosto de fazer cada coisa em um arquivo separado, o mesmo acontece para as 

linhas. Faça uma cópia do arquivo anterior (da pista) e abra essa cópia no GMax, vamos 

trabalhar com as linhas e marcações nos baseando pelos aprons e taxiways que acabamos de 

criar. Vamos lá. 

Antes de tudo, temos que criar o objeto que será repetido ao longo da linha. No menu 

‘Create’, selecione ‘Shapes’ e depois ‘Rectangle’. Agora no viewport ‘Front’, desenhe um 

retângulo de 1 metro de ‘Length’ (comprimento) e 0.5 m de ‘Width’ (largura). Essa vai ser a 

largura da linha de taxi. 
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Feito isso, converta esse retângulo para ‘Editable Spline’. Ainda com ele selecionado, entre no 

modo ‘Segment’, selecione as 3 arestas inferiores do retângulo ( esquerda, direita, baixo ) e 

delete-as. Vai sobrar somente uma linha superior. Selecione essa linha ( ainda no modo 

‘Segment’ e defina a sua altura para 0 ( digite 0 na caixa de texto referente ao eixo Z, no 

rodapé da janela do GMax ). 

 

A nossa referência está pronta. Recomendo dar um nome que chame atenção a esse spline, 

algo como ‘SPLINE_TEMPLATE’, pois fica mais fácil de achá-lo na lista de objetos. 

Para criar as nossas linhas guias, você pode usar os shapes ‘Line’ e ‘Arc’ do próprio GMax. Crie 

toda a malha de linhas que for necessária, pois a conversão para lofts fica mais fácil depois que 

está tudo pronto. 

 

Por enquanto são apenas linhas, vamos agora transformar essas linhas em polígonos com a 

largura determinada pelo spline que foi criado. Para isso, você deve selecionar a linha/arco, ir 

para a aba ‘Create’, em seguida clicar em ‘Geometry->Compound Objects->Loft’. No menu da 

direita, clique em ‘Get Shape’ e em seguida clique sobre o spline que você criou ( 

SPLINE_TEMPLATE ). Um método rápido de selecionar o spline é utilizando o recuso ‘Select by 

Name’ do GMax, no menu superior, ao lado do botão de mover. 

Assim que você selecionar o spline, o polígono com 0.5m de espessura será criado em toda a 

extensão daquela linha ( aproxime com o zoom e você o verá ). 
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Pronto! Nossa linha de taxi está criada. Você pode, se quiser, aplicar uma textura à essa linha. 

Basta criar um material e aplicar ao Loft ( a vantagem é que a textura segue o percurso, ou 

seja, você não precisa se preocupar com mapeamento de textura ). 

Repare também que você consegue configurar algumas coisas do Loft no menu direito. A mais 

importante delas é ‘Shape Steps’ e ‘Path Steps’ ( dentro da sessão ‘Skin Parameters’ ). Essa 

propriedade controla a resolução das curvas. Quanto menor o número, menos suave a curva 

será. Se tiver usando arcos, um valor em torno de 5 está de bom tamanho. Se for uma linha, 

coloque 0 nos 2 campos. 

Esse método é utilizado para todas as marcações. Alguns exemplos: linha central de taxi, linhas 

das bordas de taxi, parkng lines, linhas divisórias, ponto de espera, entre muitos outros. Veja 

na imagem abaixo um exemplo das diversas aplicações. Lembrando que você pode fazer as 

marcações utilizando planos comuns também ( é melhor quando tiver que mapear alguma 

região grande no solo, como aqueles quadrados vermelhos riscados na área de 

estacionamento ou textos escritos no solo ). 
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O método de exportação é o mesmo de sempre, você já deve saber os procedimentos. Só não 

se esqueça de deletar os aprons/pista/taxiway antes de exportar as linhas, caso contrário você 

terá aprons duplicados ( lembre-se de queles só serviram de base para saber onde posicionar 

as linhas ). Quando for editar o arquivo ASM, coloque as marcações na camada mais alta ( 

sugiro a camada 20 ). Depois de compilado, mova o BGL e converta as texturas, como sempre. 

No estágio atual, voce deve ter 3 arquivos na sua pasta ‘scenery’ do FS ( provavelmente 

também tenha 3 arquivos do GMax, já que no decorrer do guia você fez 3 cópias dele ): 

 BGL do solo – Contém somente os planos do foto-real. 

 BGL das superfícies – Contendo somente a pista ( e suas marcas ), as superfícies de taxi 

e estacionamento ( aprons ). 

 BGL das marcas – Contem somente as linhas de taxi e qualquer outro tipo de 

marcação. 
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8. MODELANDO OS OBJETOS 3D 

8.1 O terminal principal 

Esse é o capítulo que mais exige do modelador, pois é aqui que ele realmente vai mostrar a sua 

arte de modelagem. Eu não vou ensinar como modelar, nem vou ensinar as ferramentas do 

GMax para se fazer um bom modelo (até porque eu não sou muito bom em modelagem no 

GMax), vou apenas indicar os procedimentos para que o seu modelo seja compatível com o 

FS2004.   

Para modelar as construções, eu sugiro usar aquela imagem foto-real como referência, na 

mesma posição. Assim fica fácil de saber se o objeto está posicionado corretamente ou não no 

próprio GMax. Sugiro então fazer mais uma cópia daquele primeiro arquivo do GMax, que só 

continha a imagem foto-real aplicada aos planos. 

Sobre essa imagem você pode iniciar a modelagem do seu edifício. Como eu mencionei, não 

vou explicar como modelar. Se quiser ter uma base mais sólida de modelagem 3D, recomendo 

aquele tutorial que vem junto com o GMax Gamepack para o FS2004 (ele explica a modelagem 

e texturização de uma casa). Aqui está o terminal de Maringá que eu modelei e texturizei para 

esse projeto (eu utilizei aquele foto-real somente para ter base do local onde o terminal se 

localiza e depois deletei o foto-real, deixando somente o terminal principal). 

 

Antes de exportar o terminal para o FS, nós precisamos determinar as texturas noturnas dele.  

8.2 Texturas noturnas 

Aplicar as texturas noturnas em qualquer objeto é bem simples. Antes de tudo você precisa ter 

as texturas já com a iluminação noturna. Veja um exemplo abaixo de uma imagem diurna e 

outra noturna 
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Há uma restrição a ser seguida nessas imagens. Se o nome da textura diurna for ‘textura.bmp’, 

o nome da textura noturna vai ser ‘textura_lm.bmp’. Resumindo, você deve adicionar o sufixo 

_lm nas imagens noturnas. 

Agora que temos as 2 imagens, vamos aplicá-las ao nosso modelo. Quando é dia, o FS carrega 

as texturas que foram aplicadas como um material ‘Diffuse’. Já a noite, ele carrega as que 

foram aplicados como um ‘Ambient’. Então o que você deve fazer é simplesmente adicionar a 

imagem noturna como ‘Ambient’  lembre-se de destravar o cadeado que se encontra ao lado 

do Diffuse/Ambient). Veja a imagem: 

 

Tudo pronto, vamos exportar para o FS2004 agora.  
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Lembre-se de que agora nós estamos trabalhando com um objeto 3D. Isso quer dizer que 

vamos deixar de lado os utilitários do FS2002 e vamos usar os do FS2004. 

Vá em ‘File->Export’, salve com um nome qualquer e como um ‘Flightsim Aircraft’, como antes. 

Configure o MakeMDL Middleman da mesma forma e salve o arquivo X. Com o X exportado, 

abra o MakeMDL do FS2004 (preste atenção, é o MakeMDL do FS2004 agora). Selecione o 

arquivo X e em ‘Model Type’ escolha ‘SceneryFS9’. Vá para a aba ‘Options’ e deixe-a desta 

maneira: 

 

Clique em ‘Start’. Se tudo correu bem, você deve ter um arquivo MDL e um arquivo XML na 

pasta onde está o X. 

Abra o arquivo XML no bloco de notas. Nele você vai configurar as coordenadas do objeto, 

altura, rotação. Vamos antes analisar o conteúdo do arquivo: 

lat – Latitude. Coloque aqui as coordenadas S/N retiradas do FS. Lembre-se de que se for S, 

você deve adicionar o sinal de menos ( - ) antes da coordenada. 

lon - Longitude. Coloque aqui as coordenadas W/E retiradas do FS. Lembre-se de que se for W, 

você deve adicionar o sinal de menos ( - ) antes da coordenada. 

alt – Altitude. Esta é a altitude do objeto. Deixe em “0”, vamos explicar mais um pouco logo a 

seguir. 

heading – Direção. É a direção para onde o modelo vai apontar, da mesma forma que no avião, 

de 0 a 360. 

altitudeIsAgl – Isso determina se a Altitude mencionada acima vai ser em relação ao SOLO ou 

ao nível do MAR. Se for em relação ao SOLO, deixe ele como “TRUE” e sete a altitude como 

“0”, que é o mais recomendado. 

imageComplexity – Nível de complexidade. Esse campo determina a partir de que nível de 

complexidade configurado no FS2004 que o objeto vai aparecer. Recomendo deixar em 

“NORMAL”. 

sourceFile – Nome do arquivo MDL fonte. Normalmente esse campo já está preenchido 

corretamente, mas caso você tenha alterado o nome do MDL, altere aqui também. 
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No nosso caso, precisamos somente alterar as coordenadas. Você vai utilizar as mesmas 

coordenadas que você utilizou no MakeMDL, substituindo o S/N/W/E por +/- e removendo o 

asterisco (Norte e Leste são positivos, Sul e Oeste negativos). 

S23* 28.68 W52* 01.57 -> -23 28.68  -52 01.57 

Antes de salvar o XML com os dados atualizados, remova o “<!—“  que vem ANTES do 

“<SceneryObject...”  e remova também o “-->” que vem APÓS o  “</SceneryObject>”. NÃO 

REMOVA NENHUM OUTRO COMENTÁRIO, SOMENTE ESSES DOIS! 

Ele deve ficar semelhante á isso: 

<?xml version="1.0" encoding="ISO-8859-1"?> 

<FSData version="9.0" xmlns:xsi='http://www.w3.org/2001/XMLSchema-instance' 

xsi:noNamespaceSchemaLocation="bglcomp.xsd"> 

 <!-- Sample object placement.  Remove comment markers to place object 

east of 34R at Sea Tac. --> 

 <SceneryObject lat="-23 28.68" lon="-52 01.57" alt="0" pitch="0" 

bank="0" heading="0" altitudeIsAgl="TRUE" imageComplexity="NORMAL"> 

  <LibraryObject name="83A081CE463F8CE410C5048173D15989" 

scale="1.0" /> 

 </SceneryObject> 

 <!-- Inclusion of model data.  Use the 'Name' of this object to place-->  

 <!-- it in other locations. -->  

 <ModelData name="83A081CE463F8CE410C5048173D15989" 

sourceFile="terminal.mdl" /> 

</FSData> 

Pode salvar esse arquivo XML. Para compilar o BGL do nosso cenário, basta arrastar o arquivo 

XML sobre o executável do BGLComp 2004 (deixe o XML na mesma pasta do MDL). Se tudo 

ocorreu como deveria, um BGL foi criado. Esse é o nosso terminal. Mova-o para a pasta do 

cenário do FS, converta as texturas necessárias e confira o resultado. 

8.3 Adicionando detalhes 

Esse item é apenas uma dica. 

Nenhum aeroporto é composto apenas por uma pista e uma construção de 

embarque/desembarque. Sempre tem carros, postes, grades, escadas, árvores, etc.. Esse tipo 

de objeto dá vida ao aeroporto.  

Não vou explicar como fazer, pois você já é capaz de fazer isso sozinho. Adicione pelo menos 

alguns postes de luz e uma grade cercando a área do aeroporto. Somente esses dois detalhes 

já dão um novo ar ao aeroporto. Cabe a você também decidir se quer adicionar os detalhes no 

mesmo arquivo do terminal ou em um arquivo separado. 
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9. ILUMINAÇÃO NOTURNA 

9.1 Criando luzes para pista, táxi e aprons 

Você talvez não tenha notado, mas depois que você colocou o solo foto-real, a luzes da pista 

desapareceram, assim como as de táxi e aprons. Sempre que utilizar esse método de foto-real, 

vai ter que fazer a iluminação por conta própria. Você deve estar se perguntando: então 

porque fazer dessa maneira? Não é melhor usar um programa comum para criar o foto-real? 

Depende. Se utilizarmos o método comum (com o Sbuilder ou qualquer outro editor), a 

melhor resolução que vamos conseguir é de 1.2m/pixel, enquanto que no GMax a resolução é 

livre. Resumindo: ou você tem algo de baixa resolução que não da trabalho, ou você tem algo 

com uma resolução perfeita tendo que suar a camisa. 

Se você chegou até aqui, eu vou supor que esteja interessado na segunda opção. Se prepare, 

porque agora o processo é bem trabalhoso e necessita muita atenção. 

Para começar, nós precisamos da luz em si. Eu optei por usar as chamadas BGL Lights ao invés 

de efeitos, por alguns motivos: 

 Fazer iluminação com effects faz com que as luzes tenham uma intensidade baixa 

demais, e desaparecem por completo a determinada distância. Isso é inviável para 

pistas de pouso, por exemplo (para iluminação de táxi elas servem).  

 Efeitos também têm um sério problema de visibilidade. Se você sai do alcance do 

efeito e depois retorna, ele fica desativado. Há como contornar isso, mas demanda 

mais trabalho do que usar luzes BGL. 

Mas o que são essas BGL Lights? Nada mais nada menos do que um código ASM que deve ser 

compilado em um arquivo BGL, como de um cenário. A diferença é que ele deve ser compilado 

em um BGL do FS2004, mas nenhum dos compiladores lê arquivos ASM e compila em BGL para 

o FS2004. Para isso nós vamos utilizar o BGLC_9, que faz exatamente o que precisamos. 

Vamos lá. Eu vou colocar aqui o código ASM da luz e explicar um parâmetro importante. 

        db  'R','I','F','F'    ; RIFF file identifier 

    dd  bgl_data_end - $ - 4      ; size of RIFF data 

    db  'M','D','L','9'    ; file identifire (FS9 model) 

 

    db  'M','D','L','H' 

    dd  visual_model_header_end - $ - 4 

    dd  visual_model_header_end - $ - 4 

    dd  0 

    dd  0 

    dd  2 

    dd  0 

    dd  0 

    dd  156 

    db  'F','S','8','0' 

    dd  2304 

visual_model_header_end  label dword 

 

    db  'I','S','F','T'    

    dd  ver_end - $ - 4   

    db  "BGLC_9",0 

ver_end label word        

 

bounding_box_riff_start label word 

    db  'B','B','O','X'    

    dd  bounding_box_riff_end - $ - 4 
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    real4  -100.000, -100.000, -100.000   

    real4  100.000, 100.000, 100.000   

bounding_box_riff_end label word        

 

 

model_outside    label    BGLCODE 

model_shadow label BGLCODE 

model_inside  label    BGLCODE 

exterior_riff_start_0 label BGLCODE 

    db  'E','X','T','E'    

    dd  exterior_riff_end_0 - $ - 4 

LOD_0L    label    BGLCODE 

 

LIGHT_NAV_beta_top label BGLCODE 

 

bgl_riff_start_LIGHT_NAV_beta label BGLCODE 

    db 'B','G','L',' ' 

    dd bgl_riff_end_LIGHT_NAV_beta - $ - 4 

LOD_0_LIGHT_NAV_beta label BGLCODE 

 

; Alpha 

LIGHT_NAV_beta_Alpha label BGLCODE 

    BGL_CALL_32 LIGHT_NAV_beta_MasterScale_1        ; Node 1 - MasterScale 

    BGL_END 

    BGL_RETURN 

 

 

LIGHT_NAV_beta_MasterScale_1 label BGLCODE 

 

    IFIN1 bgl_data_end, 028Ch, 2, 4 

    BGL_LIGHT LIGHT_NAV, 0.0, 0.0, 0.0, 0, 0.0, 0.0, 0FFABABABh, 0.000000, 0.000000, 

0.000000 ; Color is AB AB AB (rgb) 

    BGL_RETURN 

 

 

bgl_riff_end_LIGHT_NAV_beta label BGLCODE 

exterior_riff_end_0 label BGLCODE 

 

 

shadow_riff_start_0 label BGLCODE 

  db 'S','H','A','D'  

  dd shadow_riff_end_0 - $ - 4 

SHADOW_0L label BGLCODE 

 

Kill_Shadow_top label BGLCODE 

bgl_riff_start_Kill_Shadow label BGLCODE 

  db 'B','G','L',' ' 

  dd bgl_riff_end_Kill_Shadow - $ - 4 

 

LOD_0_Kill_Shadow label BGLCODE 

  BGL_END 

  BGL_RETURN 

 

bgl_riff_end_Kill_Shadow label BGLCODE 

shadow_riff_end_0 label BGLCODE 

 

 

bgl_data_end label     BGLCODE    

 

Copie esse código para um arquivo de texto qualquer e salve-o com a extensão ASM (o nome 

fica a sua escolha).  

Todo esse código vai gerar aquele glow, que são as luzes de solo do FS. O parâmetro mais 

importante no código (e provavelmente o único que você vai modificar) é a cor. Ela está nessa 

linha: 

BGL_LIGHT LIGHT_NAV, 0.0, 0.0, 0.0, 0, 0.0, 0.0, 0FFABABABh, 0.000000, 0.000000, 

0.000000 ; Color is AB AB AB (rgb) 
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A cor está no formato hexadecimal, e nesse exemplo vale FFABABAB. (A R G B). O H no final 

indica que é um valor na base 16. Essa cor ABABAB nos dá uma luz branca, semelhante às luzes 

das bordas da pista. Você vai criar um BGL para cada cor que precisar. 

Vamos então transformar isso num BGL. Antes de tudo, você precisa extrair o conteúdo do zip 

do BGLC_9 para algum lugar. Feito isso, crie um atalho para ele. Em seguida, abra as 

propriedades do atalho e adicione ‘-mdl’ ao final do texto no local ‘Destino’ (esse argumento 

fará com que seja exportado um arquivo no formato MDL). 

 

Clique em OK. Agora se deve arrastar o arquivo ASM da luz sobre esse atalho. Vai ser gerado 

um arquivo MDL no final do processo. Esse MDL nós vamos compilar em um BGL como se 

fosse um arquivo de cenário para o FS2004. Para isso nós precisamos, juntamente com o MDL, 

de um arquivo XML. Vamos criar um então: 

<?xml version="1.0" encoding="ISO-8859-1"?> 

<FSData version="9.0" xmlns:xsi='http://www.w3.org/2001/XMLSchema-instance' 

xsi:noNamespaceSchemaLocation="bglcomp.xsd"> 

 

 <ModelData name="1032944E44E2961C2CC58AAA1DAD583B" 

sourceFile="spotlight.mdl" /> 

</FSData> 

 

Copie isso para um novo arquivo de texto e salve com o mesmo nome do MDL, mas na 

extensão XML. Mantenha-o sempre junto do arquivo MDL. 

Lembre-se de alterar o nome do arquivo MDL nesse código (no meu caso está spotlight.mdl). 

Outra coisa importante é aquela seqüência alfanumérica de 32 caracteres. Essa seqüência é 

como se fosse o RG do BGL, é a sua identificação. Não pode existir dois BGLs com essa mesma 

seqüência, então para cada luz/objeto, você vai ter que nomear uma seqüência diferente 
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(pode-se inventar essa seqüência, contanto que tenha 32 caracteres). Anote ou copie esse 

número em algum lugar, pois vamos usar ele mais adiante. 

Agora, com o XML e o MDL juntos, você vai usar o BGLComp do FS2004 ( atenção novamente ) 

para gerar o BGL final. Simplesmente arraste esse XML sobre o BGLComp 2004 e o arquivo BGL 

será gerado. Pode copiar esse arquivo para a pasta do seu cenário ( ‘meucenario\scenery’). 

Todo esse processo foi para criar um spotlight básico. Nós vamos utilizar ele para fazer a nossa 

iluminação. 

Faça uma cópia do arquivo gmax onde estão os aprons/pistas e renomeie para algo como 

‘luzes.gmax’. Abra esse arquivo. Novamente, servirá somente como referência para onde 

colocar as luzes. 

O processo é relativamente simples, mas trabalhoso. Consiste em criar diversas Boxes ( uma 

para cada luz ) e adicionar um objeto a cada uma delas ( que no nosso caso, é o BGL da 

spotlight ). Para as luzes da pista, eu sugiro utilizar a ferramenta ‘Spacing’, que repete um 

mesmo objeto ao longo de uma linha em determinadas distâncias.  

Crie um ‘Box’ em qualquer lugar por enquanto, com dimensões de 10x10x10 metros e 

certifique-se de que a base do cubo esteja na altura 0. Depois, crie uma linha em toda a 

extensão da lateral da pista. 

 

Agora vá em ‘Tools->Spacing Tool’. Nessa janela você pode configurar as propriedades do 

espaçamento. De uma atenção especial aos campos ‘Count’, ‘Spacing’ e a caixa ‘Follow’. Os 

valores vão depender do seu cenário e das suas preferências. Eu utilizei 42 luzes espaçadas a 

cada 51 metros. Para fazer a repetição, selecione a caixa, clique em ‘Pick Path’ e selecione a 

linha guia. Você pode alterar os valores e ver o resultado na hora. Quando estiver satisfeito, 

clique em ‘Apply’. 
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Faça isso quantas vezes forem necessárias. Posicione as caixas manualmente caso seja 

necessário (nos aprons talvez você precise). Depois que tiver todas as caixas posicionadas, 

vamos adicionar o spotlight a uma por uma. 

Infelizmente esse processo ainda é feito na mão. Há a possibilidade de fazer um script que 

automatize o processo, mas ainda não descobri como fazer, então por enquanto vai ter que ter 

muita paciência e adicionar os spotlights para cada caixa manualmente. 

Vá em ‘MAXScript->Run Script’. Navegue ate a pasta onde você instalou o gamepack do 

FS2004, entra na pasta ‘scripts’e selecione ‘AttachToolGmax.ms’. Ele vai pedir por um diretório 

de efeitos, mas como não vamos usar efeitos, você pode especificar um diretório qualquer. 

Na janela do script, selecione ‘Object’. No campo ‘Object Name’, de um nome qualquer para o 

objeto (vou usar Luz01) e no campo ‘Custom GUID’ coloque aquela seqüência alfanumérica do 

spotlight, que representa a sua identidade. 
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Feito isso, selecione um dos Boxes (ainda com a janela do script aberta) e depois clique em 

‘Attach na Object!’. Sim, você vai ter que fazer isso para cada uma das caixas, mas sempre 

incrementando ou alterando o ‘Object Name’ de cada objeto (Luz01, Luz02, Luz03...). Nunca 

use o mesmo nome. 

Terminado o processo, crie um ‘Box’ gigante que envolva todas as luzes e aplique um material 

completamente transparente nele (Opacity = 0). Se não fizer isso, você vai receber um erro ao 

tentar compilar o BGL. 

Esse processo é o mesmo para qualquer ponto de luz que você deseja adicionar, seja ele 

iluminação da pista, luzes de aproximação ou até mesmo uma iluminação qualquer no seu 

terminal (lembrando que ele não ilumina, é apenas um brilho). 

 

Vamos exportar para o FS somente as caixas e o box transparente. Delete todo o resto 

(provavelmente você vai deletar as superfícies de apron, que eu mencionei que seriam 

utilizadas somente como referência). Exporte para X como sempre, e repita EXATAMENTE o 

mesmo processo que você fez quando exportou o terminal 3D. Se não lembra direito, releia 

aquele trecho. No final de tudo, vai sair um arquivo BGL que você pode mover para a pasta do 

cenário. 

9.2 Iluminações do solo 

Essa iluminação consiste em fazer com que os solos de estacionamento “recebam” alguma luz. 

Há duas maneiras de fazer isso: com efeitos, ou usando uma textura noturna (como fizemos no 

terminal de embarque). Eu optei por utilizar o modo da textura noturna, é mais fácil e você 

tem mais controle sobre a iluminação. 

Como se trata de um processo exatamente igual ao do terminal, eu não vou explicar como 

proceder. Você vai precisar das texturas noturnas do solo do aeroporto (aquelas 1x1, 1x2), 

com o sufixo _lm (1x1_lm.bmp, 1x2_lm.bmp). Tendo as texturas, basta abrir aquele arquivo do 

solo foto-real no GMax e aplicar essas texturas noturnas  como ‘Ambient’ (veja o capítulo 8.2 

deste tutorial caso tenha alguma dúvida). Depois é só re-exportar o arquivo. 
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10. AFCAD 

Algumas vezes, as taxiways, pistas, parkings do cenário foto-real diferem do AFCAD padrão do 

FS, devido a imprecisões e simplificações. É sempre recomendável que você verifique se o as 

posições do AFCAD.  

Como você já tem o FSUIPC instalado, você pode abrir o AFCAD do seu aeroporto no AFCAD 

2.21 e iniciar o FS junto com ele. Assim que você posicionar o seu avião no aeroporto, uma 

cruz vermelha irá aparecer, indicando a posição do avião. Agora o que você tem que fazer é 

simplesmente navegar pelo seu aeroporto no FS e verificar se as posições das taxiways, 

parkings, etc. estão corretas. 

Como o AFCAD não vai aparecer, pois o solo foto-real o sobrepõe, tente evitar ao máximo criar 

polígonos, já que eles não serão visíveis. Remova todas as luzes, todas as marcas possíveis no 

AFCAD, pois elas já existem no nosso foto-real. Recomendo, para as taxiways, utilizar ‘Apron 

Taxi Link’ (marcado em vermelho na figura abaixo), pois esse método não gera polígonos. 

Resumindo, remova tudo o que o nosso solo foto-real já tem. 

 

Quando finalizar o AFCAD, salve ele na sua pasta do cenário. 

OBS.: Ocorreu um imprevisto no cenário que eu escolhi para esse tutorial. SBMG no FS é o 

ICAO do aeroporto de Maringá, que atualmente está desativado e SBMH é esse aeroporto que 

nós trabalhamos (Regional de Maringá). Parece que depois que SBMG foi desativado, SBMH 

passou a atender pelo ICAO de SBMG (mas no FS ainda não). Isso não atrapalhou em nada o 

desenvolvimento, é apenas uma questão de nome. A única diferença é que ao invés de ir para 

SBMG, devemos criar um vôo em SBMH. 
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11. DISTRIBUINDO O CENÁRIO 

11.1 Organizando as pastas 

No estado atual que o cenário se encontra, provavelmente você já tem as pastas organizadas 

corretamente dentro do FS, mas vamos relembrar. Os cenários customizados ficam dentro da 

pasta ‘Addon Scenery’ do FS. Cada cenário tem sua própria pasta dentro desse diretório, a qual 

ainda tem mais duas subpastas: ‘scenery’ e ‘texture’. Na pasta ‘scenery’ ficam todos os 

arquivos BGL do cenário (já vamos recordar cada um deles) e na ‘texture’ todas as texturas. 

Você vai encontrar uma estrutura basicamente assim: 

 ...\Addon Scenery 

o \meucenário 

 \scenery 

 \texture 

Vamos relembrar os arquivos que você vai ter na pasta ‘scenery’: 

 BGL do solo foto-real 

 BGL do polígono de exclusão e terraplanagem 

 BGL dos aprons, pistas e taxiways 

 BGL das marcações 

 BGL do terminal principal e dos detalhes 

 BGL da spotlight básica 

 BGL de todo o sistema de luzes 

 BGL do AFCAD 

Na pasta ‘texture’ vão constar todas as texturas (normais e noturnas) que os seus BGLs 

utilizam. Todas elas devem estar no formato BMP e devem seguir algumas regras: as 

dimensões devem sempre ser em potência de dois (2x2, 4x4, 16x16, 256x256 e assim por 

diante) e nos formatos 32 bits, DXT 1/2/3. 

Lembre-se também que para o cenário aparecer no FS, você deve adicionar essa pasta na lista 

de ‘Addon Scenery’. Para fazer isso, abra o FS, vá em ‘Settings->Scenery Library->Add Area’ e 

selecione a pasta base do cenário (\meucenário, por exemplo). 

11.2 Gerando um instalador 

Um modo fácil de distribuir um cenário é usar um instalador, que faz a cópia automaticamente 

dos arquivos para a pasta correta. Tem centenas de instaladores por aí, como InstallShield, 

NSIS, WinZip Self Extractor, WinRar SFX, etc... 

Eu vou puxar a sardinha um pouco pro meu lado e vou utilizar um instalador que eu mesmo fiz. 

Há duas versões dele: Fergo InstallMaker e Fergo InstallMaker Lite. A diferença dos dois é que 

o Fergo InstallMaker é um instalador completo, em que você pode adicionar textos, atalhos, 

registro de componentes, etc. Já o Lite nada mais é do que um self-extractor, que extrai o seu 

conteúdo para uma pasta qualquer, sem muitas opções de configuração. (para maiores 
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informações você pode visitar o site www.fergonez.net). O Fergo InstallMaker Lite pode ser 

encontrado neste link: http://www.fergonez.net/files/fim_lite.zip 

Ele não oferece quase nenhuma opção de personalização (caso queria isso, utilize o Fergo 

InstallMaker completo). 

Antes de gerar o instalador, crie uma pasta com um nome qualquer no seu desktop. Após isso, 

selecione a pasta do seu cenário (inclusive ela) e copie para dentro desta pasta no desktop. 

 

Abra o Fergo InstallMaker Lite. O visual é bem simples, tem somente três lugares para 

configurar, que já são auto-explicativos. Dê um nome ao seu projeto, escolha o idioma e a 

pasta de origem dos arquivos. Selecione aquela pasta que você criou no desktop (‘final’, como 

no meu caso) como sendo a pasta de origem: 

 

Depois de configurado, basta clicar em ‘Compilar...’, selecionar o diretório de destino do 

executável instalador e aguardar a criação do mesmo (pode demorar alguns instantes, pois ele 

comprime todos os arquivos antes de adicionar ao instalador). Se a compilação for bem 

sucedida, você receberá uma mensagem indicando que o instalador foi criado com sucesso e 

que o executável auto-instalável foi criado no diretório escolhido.  

Lembre-se de colocar um aviso junto ao link de download avisando o local onde o arquivo deve 

ser extraído ( na pasta ‘Addon Scenery’ do FS ). Se você quiser incluir esse aviso no próprio 

instalador, use a versão completa dele ( disponível no site mencionado logo acima ). 

http://www.fergonez.net/
http://www.fergonez.net/files/fim_lite.zip
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Seu cenário agora está finalizado, empacotado e pronto para distribuição. Basta distribuir o 

instalador. 
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12. CONCLUSÃO 

É isso aí pessoal! Espero ter sido claro no decorrer de todo o tutorial para que a criação de 

cenários para o FS deixe de ser aquela complicação toda. Pretendo continuar atualizando esse 

guia a medida que eu ganho mais conhecimento e que novas ferramentas apareçam por aí. 

Agradecimentos especiais ao fórum SceneryDesign ( www.scenerydesign.org ), especialmente 

ao Arno, que possui um conhecimento e uma paciência incrível. Agradecimentos também ao 

rupo TerraBrasilis ( www.terra-brasilis.org ), do qual tenho a honra de fazer parte. 

Esse tutorial é completamente gratuito, sendo proibida a sua venda ou modificação sem 

prévio aviso. Todas as ferramentas utilizadas pertencem aos seus respectivos donos. 

CENÁRIOS PARA O MICROSOFT FLIGHT SIMULATOR 2004 

Fernando Augusto Birck – Fergo – Todos os direitos reservados 
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Revisões: 
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o Lançamento da primeira versão 

 Junho 2007 – 1.1 

o Correção de erros de gramática e concordância. 

o Correção do processo de gerar o MDL a partir do ASM/X. 

o Sumário remodelado. 

o Adicionado link para baixar os arquivos utilizados no tutorial. 
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